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1. Introduction 
This document is for system administrators who have already reviewed the Brekeke PBX 

Administrator’s Guide (Basic). This document provides more detailed and advanced information 

f the Brekeke PBX. 

rekeke PBX 
esses are initiated; Brekeke SIP Server (bundled SIP 

eke PBX main process, and the process for media server 

 between SIP User 

As). All call sessions between caller and callee are mediated by the Brekeke PBX 

dia Server Process 
The media server process handles some Brekeke PBX features, such as voicemail, and auto 

attendant.  

 

about each function o

 

2. Processes on B
When Brekeke PBX is started, three proc

server for Brekeke PBX) process, Brek

(voicemail/IVR features).  

 

 

 

 

 

 

 

 

 

 

2.1. Main Process 
The Brekeke PBX main process receives and dispatches SIP sessions

Agents (U

 

Brekeke PBX  

Media Server Process 

Brekeke PBX 

Main Process 

Brekeke SIP Server 

(for PBX) Process

main process.  

 

2.2. Me
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3. About RTP Relay 
Depending on your operating environment and its requirements, and to ensure proper SIP 

communications, the RTP relay through Brekeke PBX may be necessary. 

-relay) method, and 

mmands, such as Call Forwarding, Call 

rver. 

not support changing 

ckets need to be relayed 

ring a call, select 

c Priority] in Brekeke 

ll depending on SIP 

pes of SIP devices. 

“off” (which is 

er than G.711u. 

 

tions, ARS Settings, 

e] have the highest 

r [ARS Settings] are 

. When User Settings and ARS Settings are set to the defaults, the settings at [Options] 

are applied. 

f”. When one of 

X. By increasing the 

e load will increase. 

andles RTP for some features 

such as Music On Hold and Voicemail. Thus, depending upon the type of usage and 

h setting. 

orts not only codec G.711 u-law but also G.729 (Optional), G.711 A-law and 

iLBC. When the RTP relay setting is set to “on”, Brekeke PBX will do codec conversions 

between different codecs. So, both parties can talk each other without problems even when they 

are using different codecs. 

 

♦ If you are using a SIP UA that does not support the SIP-INFO (DTMF

wish to use Brekeke PBX features using key pad co

Park, Call Recording, etc., RTP packets need to be relayed through the Media Se

♦ If you are using SIP devices (SIP UA, SIP proxy server, etc.,) that do 

RTP sender information by receiving re-INVITE requests, RTP pa

through the Media Server. 

♦ If you are using SIP devices that do not allow changing a voice codec du

“on (G.711u only)” at RTP relay setting or “0 (G.711u only)” at [Code

PBX setting. Selecting “off” at RTP relay setting may not work we

devices and there may be compatibility issues between different ty

Thorough testing is recommended before deciding to set RTP relay setting to 

not G.711u only) options or use a codec oth

RTP relay settings can be set under several locations in Brekeke PBX: Op

and User Settings. The settings under Users > [Phones] -> [Phone Typ

priority. When the default setting is defined in [Phone Type], settings unde

applied

 

RTP relay will be turned off only when both end points are set to RTP relay “of

the end points require RTP relay, RTP will be relayed through Brekeke PB

amount of RTP packets handled by Brekeke PBX, the Brekeke PBX machin

Even when the RTP relay setting is set to “off”, Brekeke PBX h

environment, the maximum number of concurrent session can vary for eac

 

Brekeke PBX supp
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4. SIP Server Relationships 
4.1. Brekeke PBX and the Bundled SIP Server Relationship  

A SIP server is embedded in Brekeke PBX. If you log in to Brekeke PBX as an Administrator, 

 the bundled SIP server. The bundled SIP server is a SIP 

 a VoIP network and processes SIP 

ates another session 

ned phones and 

ed SIP Server 
ngs in the Dial Plan.  

From PBX 

ial plan rule will be applied to the sessions coming from Brekeke PBX that do not match 

stination. 

 

 ITSP 

record will be routed 

ntication is false. 

rom reistered UAs, will be routed to Brekeke PBX with UDP 

transport and without authentication checking. 

ject 

All the other incoming calls, which cannot apply any of above rules, will be rejected with 404 not 

 response. 

Subscribe 

IBE requests for Message Waiting Indicator (MWI), presence, BLF, SCA and for 

 

Thru Register 

REGISTER requests from Brekeke PBX will be applied when Brekeke PBX is registering to the 

you can also access and manage

proxy server which provides call session management in

requests and responses. When Brekeke PBX receives a call session, it initi

with the appropriate destination according to user settings, such as assig

forwarding destinations, and then joins the two sessions. 

 

4.2. Default Dial Plans in the Bundl
The bundled SIP server has the following default setti

 

This d

the Dial Plan rules above it. It will disable the Authentication, and send call to de

To PBX From

All sessions from ITSP or SIP gateway devices with localhost registration 

to Brekeke PBX. B2BUA mode will be set to true and authe

 

To PBX 

The sessions, that are initialized f

 

To PBX re

found

 

SUBSCR

Multiline functions of SAXA IP Phones will be routed to Brekeke PBX. 
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third party SIP proxy server using Thru Registration. When the third party SIP proxy server has a 

global IP address, and if the bundled SIP server does not have interface for the global IP 

address, the bundled SIP server does not send REGISTER requests to the third party SIP proxy 

ress registered at an 

This dial plan is disabled by default. Edit and enable it for solving NAT issue for registration from 

 remove the underscore in either &register.contact.nat=true or 

server. This is to prevent problems with ITSPs since having a local IP add

ITSP’s proxy server tends to cause unnecessary problems.  

 

Register Behind NAT 

some UAs, and

&net.registrar.adjust.expires=10  
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5. Call Process Flow 
In this section, we explain how a call from UA1 to UA2 is processed. This graphic image 

represents the user agent’s call step-by-step. 

 

 image presented above: 

” at the bundled SIP 

es for an ARS “Pattern IN” that matches with 

ress (From) and call 

e Deploy Patterns. 

or for accessing an 

existing call, Brekeke PBX will make the call join the corresponding existing call. If not, 

Brekeke PBX will treat the call as a new call. 

4) Brekeke PBX will check the settings in [Users] > [Inbound] to determine the call destination. 
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The following items correlate to the

1) The call initiated by UA1 matches with the Dial Plan rule “To PBX

server and is routed to the Brekeke PBX. 

2) When Brekeke PBX receives the call, it search

the call. If Brekeke PBX finds a pattern, it will change the caller’s add

recipient’s address (To) as specified in th

3) If the “To” header includes a prefix for Call Pickup, Park Pickup, 

UA2 

          Brekeke PBX  

Brekeke SIP Server (bundled for PBX) 

UA1 

1 

2 

3 

5 

6 

4 
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If multiple destinations are set in [Users] > [Inbound] > [Forward To] section or some 

extension is set in [Users] > [Settings] > [Automatic Monitoring*] field, Brekeke PBX will 

process the call routings for multiple destinations in parallel with Step 5. 

call. If Brekeke PBX 

ipient’s address (To) 

d routed to UA2. 

5) Brekeke PBX searches for an ARS “Pattern OUT” that matches the 

finds a pattern, it will change the caller’s address (From) and call rec

as specified in the Deploy Patterns. 

6) The call is processed by the bundled SIP server’s Dial Plan feature an
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6. Number System 
6.1. Defining a Brekeke PBX User 

Brekeke PBX regards user extensions as Brekeke PBX users, and associates a UA SIP ID with 

y looking for the [Phone ID] field in each Brekeke PBX user [Phones] 

fined in one user [Phone ID] fields are considered as the same 

tanding Prefixes 
To provide easy access to Brekeke PBX features, such as Voicemail or IVR extensions, Brekeke 

By adding the appropriate prefix to an extension number, users can 

up. 

The prefixes used in Brekeke PBX are listed in table below. Most prefixes cannot be modified 

ettings, such as set 

 

mail. 

 

efix settings: 

each Brekeke PBX user b

page settings. All numbers de

Brekeke PBX user. 

 

6.2. Unders

PBX uses a prefix system. 

directly access the related Brekeke PBX features, such as voicemail, call pick

 

except for call pickup prefix. Users can use these prefixes in their s

forwarding destinations as vm100 then the call will be forwarded to user extension 100

voice

The table below shows the default pr

IVR prefix ivr 

Voicemail prefix vm 

Voicemail review / Setting prefix msg 

Call Pickup prefix * 

 

It is not possible to dial the prefix directly from most types of SIP devices. We have prepared the 

default ARS rule “mediaserver_prefix” so that users can dial numbers to directly access the 

Media Server features (Voicemail). 
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7. Call Forwarding 
Call Forwarding also includes Call Forwarding (No Answer) and Call Forwarding (Busy). 

 

ived at the user extension, 

the call will be forwarded to the destinations checked in the [Phone n] fields and also the 

d] page. 

 and all incoming calls are 

directed to the user’s assigned phones checked in [Inbound] page. If there are destinations 

nd extensions set in 

e time, and the first 

Different ringing time can be set to each assigned phones and extensions at [Other Forwarding 

ing for each phone’s 

ing] section will be 

s an incoming call to 

ne [Delay (sec)] field 

then direct call to this phone. 

ll Forwarding (Busy) 

answer) 

rding (Busy) 

Each user can set up forwarding for unanswered/busy calls. By default, unanswered/busy calls 

Only a single destination can be assigned in the [Forwarding destination (No answer)] and 

 multiple destinations to be used for 

these features, group extension number can be set in these fields. 

 

 In the following examples, the default setting is used for each phone ringer time. 

7.1. Call Forwarding 
Each user can set up call forwarding individually. When a call is rece

extensions set in [Other Forwarding Destinations*] field in the [Users] > [Inboun

 

By default, the [Other Forwarding Destinations*] field is left blank

specified in [Other Forwarding Destinations*] field, both checked phones a

this field will receive calls. Each extension’s phones will ring at the sam

person to answer will be connected with the caller. 

 

Destinations*] field under one user extension. When there is not any sett

[Ringer Time (sec)], the default ringer time setting under [Call Forward

applied. If there is delay time set for a user assigned phone, when there i

this user extension, Brekeke PBX will wait the delay time set in related pho

 

7.2. Call Forwarding (No answer) / Ca
These forward settings are used in the following situations:  

♦ No answer after the ringer timeout occurs --> Call Forwarding (No 

♦ Calls can not be established or received busy response --> Call Forwa

 

are forwarded to the user’s voicemail inbox. 

 

[Forwarding destination (Busy)] field. If you need to set up
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7.2.1.  Example 1: Forwarding Unanswered/Busy Calls to Voicemail  

Extension: 001 

Ringer time (sec) 15 

Forwarding destination (No answer) vm001 

Forwarding destination (Busy) vm001 

 

Incoming calls to extension 001 warded to the user’s voicemail inbox (extension vm001) if 

the call is busy or remains unanswered after ringing for 15 seconds.  

ls to Another Extension 

Extension: 001 

 are for

 

7.2.2. Example 2: Forwarding Unanswered/Busy Cal

Ringer time (sec) 15 

Forwarding destination (No answer) 16504016636 

Forwarding destination (Bus vm001 y) 

 

With this setting, if the call remains unanswered for 15 seconds, the call will be forwarded to 

16504016636 a PSTN though available ARS routes. If the call is busy, the 

to the extension 001’s vo

call will be forwarded 

icemail.  

 

ng is empty 

1 

7.2.3. Example 3: Busy Call Forwardi

Extension：00

Ringer time (sec) 15 

Forwarding destination (No nswer) vm001 a

Forwarding destination (Busy)  

 

Incoming calls to extension 001 are forwarded to the user’s voicemail inbo

remains unanswered after ringing for 15 seconds. Whe

x (vm001) if the call 

n the field for [Forwarding destination 

(Busy)] is left blank, even for the case when the call is busy, Brekeke PBX will wait for 15 

.3. More Advanced Forwarding Settings 
By combining Call Forwarding, Call Forwarding (No answer), Call Forwarding (Busy) and Ringer 

time, you may create more advanced call forwarding settings. 

 

 

seconds and then the call will be forwarded to the user’s voicemail.  

 

7
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Here are a few rules that are useful to remember: 

♦ Only a single destination can be set in the [Forwarding destination (no answer/busy)] field. 

♦ When Call Forwarding is set for the extension, the ringer time for the call depends on the 

nswer/Busy). If no one answers the call for the Ringer time, 

tination (No answer)] 

estinations could not 

g destination (Busy)] 

er Call Forwarding, 

ng destination’s [Forwarding destinations], [Forwarding destination (No answer)], 

an be transferred to 

 In the following examples, the default setting is used for each phone ringer time. 

.3.1. Example 1: Ringer Time & Forwarding Destination (No answer/busy) 

: 001 

setting of Call Forwarding (No a

original call recipient (not forwarding destination)’s [Forwarding des

will be applied (Please refer to section 7.3.1.) If all of the forwarding d

establish a call or if all forwarding destinations are busy, [Forwardin

will be applied. 

♦ After the call is forwarded by Busy Call Forwarding or No Answ

forwardi

[Forwarding destination (Busy)] settings will be used and the call c

another destination. (Please refer to section 7.3.2). 

 

 

7

Extension

Other Forwarding Destinatio 101, 102 ns* 

Ringer time (sec) 20 

Forwarding destination (No r) vm001answe

Forwarding destination (Busy) vm001

 

Extension: 101 

Other Forwarding Destinations*  

Ringer time (sec) 15 

Forwarding destination (No answer) vm101  

Forwarding destination (Busy) vm101  

 

Extension: 102 

Other Forwarding Destinatio  ns* 

Ringer time (sec) 25 

Forwarding destination (No answer) vm102 

Forwarding destination (Busy) vm102 

 

1) All incoming calls to the extension 001 > forwarded to both extensions 101 and 102 
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2) Extension 101 rings for 15 seconds and Extension 102 rings for 20 seconds and both 

extension 101 and 102 do not answer the call 

3) The call will be forwarded to the 001’s voicemail inbox vm001 

d Call Forwarding (No answer), are treated as highest 

et up call forwarding (No answer) on all of 

his/her calls. Ringer time for extension 001 is set for 20 seconds. Even after User 101’s ringer 

e forwarded to 

 to extension 001 will be transferred to both extensions 

rwarded to the 

Call Forwarding (No 

Example 2: Ring Group and Call Forwarding 

: 000 

 

User 001’s settings, Ringer time an

priority even when the user 101 and 102 have s

stops, extension 102 continues ringing to 20 seconds. Then the call will b

extension 001’s voicemail inbox (extension vm001).  

 

With the settings above, incoming calls

101 and 102. If the call is not answered by extension 101 or 102, it will be fo

destination specified in User 001’s [Call Forwarding (No answer)] field. [

answer)] settings for extensions 101 and 102 will not be used. 

 

7.3.2. 

Extension

Other Forwarding destinations* 001 

Ringer time (sec) 5 

Forwarding destination (No er) 001A  answ

Forwarding destination (Busy) 001A 

 

Extension: 001A 

Other Forwarding destinations* 100A, 200A 

Ringer time (sec) 10 

Forwarding destination (No answer) 001B 

ing destination (Busy) 001B Forward

 

Extension: 001B 

Other Forwarding destinati 100B, 200B ons* 

Ringer time (sec) 10 

Forwarding destination (No answer) vm001 

Forwarding destination (Busy) vm001 
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Extension: 100A 

Group Extensions* 101, 102, 103 

 

: 200A Extension

Group Extensions* 201, 202 

Extension: 100B 

Group Extensions 111, 112, 113, 114, 115, 116 

 

Extension: 200B 

Group Extensions 211, 212, 213, 214 

 

1) All incoming calls to extension 000 are forwarded to extension 001. 

arded to 001A. 

1, and 202 will ring. 

g even after 

ds. 

o extension 001B. 

 and 200B. 

ring. 

all is unanswered for 10 seconds, it is forwarded to the extension 001’s voicemail 

10) When vm001 answers the call, all ringing will stop. 

Meanwhile all extensions that receive the call will keep ringing until their own Ringer time setting 

h this example, we used letters for the extension numbers in order to clarify different groups. 

caller can make a call directly to a number such 

Brekeke PBX features two types of call distribution for call hunting extension: Round Robin and 

Top-Down. The round robin setting is useful if you want to distribute calls equally within a 

specific group of extensions. The top-down setting is useful if you want to distribute calls in a 

2) When a call is unanswered for 5 seconds, it is forw

3) The call is forwarded to 100A and 200A. 

4) Extensions 101, 102, 103, 20

5) If extension 001’s [Ringer Time] is more than 5 seconds, 001 will continue to rin

5 secon

6) If the call is unanswered for 10 seconds, it is forwarded t

7) The call is forwarded to 100B

8) Extensions 111, 112, 113, 114, 115, 116, 211, 212, 213, and 214 will 

9) If the c

inbox vm001. 

 

expires or the call is answered.  

 

 Wit

 If a caller is using a SIP UA which allows letters, the 

as 100B.  

 

7.4. Call Distribution for Call Hunting Extension 

 
16  Brekeke PBX Administrator's Guide (Advanced) 
 

 p-adm-120430

 



BREKEKE SOFTWARE, INC. 
 

certain order within the specific group of extensions. In either case, the system will ring each 

available extension sequentially until the call is answered. 

 

that rings first will keep changing in the order as 

specified. Every time the call will be forwarded to the next specified extension of the one that 

d the last call.  

Under top-down setting, calls are always forwarded in a specified order. With Brekeke PBX, the 

er specified in the left most in the field is given the highest priority. The same setting can 

ore simplified. 

Single Attempt 

 Single Attempt setting is set to “no” (default setting), calls will keep ringing the next 

 

ish a connection, the 

ation (No answer)]. 

 

nswers the call. If the 

swered call will be forwarded to the destination 

set at [Forwarding destination (No answer)] after one attempt. 

7 l Hunting 

0 

Round Robin 

Under round robin settings, the extension 

answere

 

Top-Down 

numb

be configured under the basic call forward settings, but top-down settings are m

 

When the

destination even after the [Ringer time] has expired.  

When the Single Attempt setting is set to “yes”, after one failure to establ

calls will be forwarded to the destination set at [Forwarding destin

Call Queue 

Using the Call Queue feature, calls are kept on hold until a specified user a

Single Attempt setting is set to “yes”, the unan

 

.4.1. Example 1: Cal

Extension: 20

Hunt group destinations* 100,101,102 

Ringer time (sec)* 10,5,5 

Waiting time in the queue (sec) 0 

Single attempt no 

Forwarding destination (No Answer) vm100 

 

Top-Down Setting 

1) Extension 100 starts ringing. 

 
17  Brekeke PBX Administrator's Guide (Advanced) 
 

 p-adm-120430

 



BREKEKE SOFTWARE, INC. 
 

2) If the call is unanswered at extension 100 after 10 seconds, extension 101 starts ringing. 

3) If the call is unanswered at extension 101 after 5 seconds, extension 102 starts ringing. 

4) If the call is unanswered at extension 102 after 5 seconds, the call is forwarded to vm100.  

t call, however, from 

the second call on, the call is forwarded to the extension after the one that answered the most 

ample 2: Call Hunting 

Extension: 200 

 

Round Robin Setting 

The Call Forwarding order is the same as the top-down setting for the firs

recent call. 

 

7.4.2. Ex

Hunt group destinations* 100,101,102 

Ringer time (sec)* 10,5,5 

Waiting time in the queue (s 0 ec) 

Forwarding destination (No swer) vm100 An

 

Extension: 101 (Call Forwarding setting [Basic]) 

Other Forwarding destinatio 200,201 ns* 

Ringer times (sec)* 20 

 

less of the settings of 

 call is forwarded to 

e call is unanswered 

ng. Extension 200 and 201 will keep 

ch the time specified in the [Ringer times (sec)*] field.  

7 l Queue 

Call Forwarding settings are enabled at each extension individually, regard

the extension the call is forwarded from. With the above example, when a

extension 101, it is directed to extension 200 and 201 simultaneously. If th

at both extensions after 5 seconds, extension 102 will ri

ringing until they rea

 

.4.3. Example 3: Cal

Extension 200 

Hunt group destinations* 100,101,102 

Ringer time (sec)* 20 

Waiting time in the queue (sec) 180 

Max number of calls in the queue 10 

Forwarding destination (No Answer) vm100 

 

The Call Queue feature is used when the time, more than 1 second, is set at the [Waiting time in 
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the queue (sec)] field.  

 

Calls are answered by the available extensions among 100, 101, or 102. The order the 

ing will depend upon the mode setting (Round Robin or Top-Down). If the call is 

unanswered, it is placed in the queue. 

0. The callers in the 

queue will hear hold music while waiting to be answered. If the call is not answered after the 

ll on the top of the queue will be forwarded 

ng 

ttempt] setting is set 

rwarding destination 

rding 

rmation.  

 

dition (period, date, hour, or Caller ID) occurs. 

(The action will be the same as the basic call forwarding setting.)  

eate a schedule extension from [Extensions] > [Schedule]. 

Forwarding Schedule 1] will 

ule menu. 

d like calls to be forwarded. When set 

[Days of week], specify which day of which week in a month. For example: Checking First 

and Sunday means the schedule will only apply to the first Sunday in every month. 

5) Set call forwarding destinations as you would under [Forward To] tab. 

 

extensions ring

 

When the calls in the queue exceed 10, the 11th call is forwarded to vm10

caller waits 180 seconds in the queue, it will be forwarded to vm100.  

 

After the period set in the [Call interval (msec)], the ca

to the available extension. When [Single attempt] setting is set for “no”, the call will keep calli

until the waiting time for the queue (180 seconds) expires. When [Single a

for "yes", the call will be forwarded to the destination specified under [Fo

(No Answer)] after one failed attempt. 

 

7.5. Schedule Call Forwa
Schedule extension call forwarding rules can be defined using by conditions based on date, time, 

Caller ID, and route info

7.5.1. Schedule Setup 

Schedule setting is applied when the specified con

 

To set up a schedule: 

1) Cr

2) Click the [Add Forwarding Schedule] button, and menu items [

appear. 

3) To define a schedule, click the [Conditions] tab. This will open the sched

4) Choose the dates and times during which you woul
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7.5.2. Example DD (Date of months) 

5,10,15,20,25 

 

d on the 5th, 10th, 15th, 20th, and 25th of each month during the 

. 

 

5-10,15-20 

This setting will be applie

specified term

7.5.3. Example: DD-DD (Date-Duration) 

 

This setting will be applied on between the 5th and 10th; and the 15th and 20th of each month 

during the specified term. 

.5.4. Example: MM/DD (Specific Date) 

 

7

5/10,5/20,6/10,6/20 

 

This setting will be applied on May 10th, May 20th, June 10th, and June 20th. 

 

ate- Period) 

/10-8/20 

7.5.5. Example: MM/DD-MM/DD (Specific D

5/10-6/20,8

 

between May 10th and June 20th, and between August 10th and 

August 20th during the specified term. 

7.5.6 /DD-MM/DD (Exclude Date- Period) 

The setting will be applied 

 

. Example: !MM

!5/10-6/20,!8/10-8/20 

 

The setting will be applied to other period of time during the specified tern excluding time period 

0th and June 20th, and between August 10th and August 20th. 

 

.5.7. Example: Time 

between May 1

7

08:30 – 13:30 

23:30 – 00:30 

 

This setting will be applied between 8:30am and 1:30pm; and between 11:30pm and 12:30am. 
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7.5.8. Example: Caller Filter 

Filter 3* 

Route From any route 

 

By adding * (wildcard) after a number, you can specify all numbers that starts with that number. 

adding “?”, you ca one number. 

 

g calls that start 

with 3 will be forwarded according to this schedule extension call forwarding setting. When [Not 

 forwarded according 

ft blank, all incoming 

When [Router] field is set to “From external line”, the incoming calls through ARS routes with 

 through ARS route 

apply this schedule 

 

 

eir own number in Group extension [group 

extensions*] from their phone instead via Brekeke PBX Admintool. 

By n specify any 

With the setting example above, when [Matched] field is checked, all the comin

Matched] field is checked, all the coming calls that start other than 3 will be

to this schedule extension call forwarding setting. When [Filter] field is le

calls will be redirected to this schedule call forwarding setting. 

 

[External] filed checked will apply this schedule setting. 

 

When [Router] field is set to “Not from external line”, the incoming calls

without [External] filed checked or calls without ARS route applied will 

setting.

7.6. Add/Remove Forwarding Destinations (IVR) 
With this feature, a user can add or remove th

 

Extension 400 

Type Add/Remove forwarding destinations 

Target groups* 300,301 

 

When user extension 200 calls into extension 400, extension 200 is added to the forwarding 

destinations for group extensions 300 and 400. If extension 200 already exists in the forwarding 

destinations for those numbers, extension 200 will be invalid as a forwarding destination (remain 

as forwarding destination with “!” in the front of the extension number).  
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8. Session Management 
You can set a maximum number of sessions that an extension can receive in [Max inbound 

sessions] under the Brekeke PBX user settings. Call sessions are counted between the 

til the phone call is terminated, or when the phone begins 

When unlimited sessions are set at [Max inbound sessions], incoming calls will ring the 

xtension is in session(s). The call is forwarded to the destination set at 

 extension after the 

t”, etc.). 

.2. Limited Sessions (0-6) 
lready has the maximum number of sessions (set at [Max inbound 

at 

 status if there is a 

sion remained to call. 

 

 Setting  
This section covers when to use Maximum Session settings. 

n multiple calls are 

he first call, are forwarded to the destination set at 

For the SIP UAs that have capacity to handle multiple sessions, users can limit the preferred 

number of simultaneous calls and make other lines available for outgoing sessions.  

beginning of the conversation un

ringing until the phone call is terminated.  

 

8.1. Unlimited Sessions 

extension even if the e

[Forwarding destination (No answer/Busy)] when it is unanswered by the

specified time (Ringer time) or conditions (SIP UA send response as “busy”, “rejec

 

8
If the callee’s extension a

sessions]) and all sessions are busy, the call will be forwarded to the destination set 

[Forwarding destination (No answer/Busy)]. The calls will stay in pending

session with ringing status until all sessions are occupied or there is no ses

8.3. Using Maximum Session

  

Preventing missed calls 

By setting [Max inbound sessions], users can avoid missing calls. Whe

coming in at the same time, all calls, except t

[Forwarding destination (Busy)].  

 

Setting the preferred number of simultaneous calls 
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9. Call Hold / Call Transfer 
9.1. Different Methods of Call Hold / Call Transfer 
9.1.1. Call Hold by re-INVITE/Call Transfer by REFER 

Hold by re-INVITE (HOLD button) and/or Call Transfer by 

e features with Brekeke PBX.  

ed at the Brekeke PBX. 

Thus, Call Hold and Call Transfer will work even if the other party’s device does not support 

ransfer using Keypad Commands 

ethod of Call Hold by re-INVITE / Call Transfer by 

MF (Keypad) for Call 

 numbers to HOLD/ 

Call Hold / Call 

e PBX Users Guide. 

 

ld 
 registered as a user 

rs >Edit] > [Keypad 

 Call Hold feature of the 

her 

f hold can 

 be resumed 

 

 

 

 

 

 

Many SIP devices support Call 

REFER (TRANSFER button). You can use thes

 

When using Brekeke PBX, re-INVITE/REFER requests are process

re-INVITE or REFER. 

 

Call Hold/ Call T9.1.2. 

Even if SIP devices do not support the m

REFER, these devices can send commands to Brekeke PBX by using DT

Hold / Call Transfer. On some devices, you may be able to assign DTMF

TRANSFER buttons and use them for Brekeke PBX proprietary method of 

Transfer. Keypad commands for Brekeke PBX are listed in the Brekek

9.2. Call Ho
Any extension using the Call Hold feature with keypad commands must be

extension of Brekeke PBX. Call Hold permissions are set in the [Use

Commands] option. In this section, Call Hold is refers to the unique

Brekeke PBX, and it is different from the Call Hold using re-INVITE requests (Section 9.1). 

ther (Figure 1), eit

n hold by using Keypad Commands (Figure 2). Taking a call of

only be done by the user who placed the call on hold, so the conversation will not

until User A takes User B off hold. 

 

9.2.1. Call Hold – Activation / Deactivation 

When Brekeke PBX user extensions A and B are on the phone with each o

user can place the call o
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9.3. Initiating Call Transfer 
After putting a call on hold, Brekeke PBX users can transfer a call to other users.  

 

old is referring to the unique Call Hold feature of Brekeke PBX, and it is different 

 

User A puts the call with User B on hold (Figure 4), and initiates a new session with User C 

ll, the session between User A and User C will be 

 

ultiple Users 

lls will be transferred 

and User D for the 

tions. (Figure 7 and Figure 8) The first user who answers the phone will be connected 

with User A. 

 

 In this section, Call H

from Call Hold using REFER requests (Section 9.1). 

9.3.1. Initiating Call Transfer 1 – Calling the Third Party 

(Figure 5). When User C answers the ca

connected (Figure 6).  

 

 

 

 

 

 

 

 

A

B

Figure 4 Figure 5 Figure 6

C

Call Hold

A

B

C

Call Hold

Calling

A

B

C

Call Hold

Talking
A

B

Figure 4 Figure 5 Figure 6

C

Call Hold

A

B

C

Call Hold

Calling

A

B

C

Call Hold

Talking

9.3.2. Initiating Call Transfer 2 – Calling M

If User C sets a [Forwarding destinations] for his/her incoming calls, the ca

to the specified destinations. In this example, User C has set User C 

destina

 

A

B

Figure 7 Figure 8 Figure 9

C

Call Hold

A

B

C

Call Hold

Calling

A

B

C

Call Hold

Talking

D D D
A

B

Figure 7 Figure 8 Figure 9

C

Call Hold

A

B

C

Call Hold

Calling

A

B

C

Call Hold

Talking

D D D
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9.4. Processing Call Transfer 
After talking with the transfer target user, you will have the opportunity to go back to the original 

session with User B.  

, and it is different from 

g REFER requests (Section 9.1). 

 

Attended Transfer 

When User A initiated Call Transfer, the call between Users A and B was put on hold. When 

s A and B’s session is connected (Figure 10, similar 

rred to User C. Now 

er C. 

r C 

. 

 

 

 

 

 

 

 Using Unattended Transfer, when User C did not answer the phone, the call between User A and B 

will be reestablished (User A’s phone will ring).  

 

 In this section, Call Hold refers to the unique Call Hold feature of Brekeke PBX

Call Hold usin

9.4.1. Processing Call Transfer 1 – 

User A hangs up the phone while User

situation with Figure 6 and 9), the call with Users A and B will be transfe

Users B and C are connected.  

 

A

B

Figure 10 Figure 11

C

Call Hold

A

B

CTalking

Talking

A

B

Figure 10 Figure 11

C

Call Hold

A

B

CTalking

Talking

 

 

 

 

 

 

 

9.4.2. Processing Call Transfer 2 – Unattended Transfer 

While the session between Users A and B are on hold, User A tries to c

(Figure 12, similar situation with Figure 6, 9, and 10) User A hangs up the p

answe

onnect with Us

hone before Use

rs the call, then the call will be transferred to User C and User B wait for User C to answer

(Figure 13) 
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9.5. Canceling Call Transfer 
You may cancel Call Transfer in the middle of the process, and either go back to talk with the 

original caller or transfer the call to the different destination.  

X and is different from 

). 

 

eling Transfer While Talking with a 3rd Party 

There are two ways to cancel Call Transfer when you are talking with a 3rd party. 

When the Call Transfer process was canceled, while User B was on hold (Figure 16, similar 

e with User A and B. 

e 3rd party 

3rd party 

cutes the cancel Call Transfer command 

♦ When a call to User C cannot be completed (User C’s phone is not connected, Call 

You can cancel Call Transfer while the phone is ringing at the destination, User C (Figure 19, 

similar situation at Figure 5 and 8). The call status goes back to the hold status between Users A 

and B.  

 

 

 

 In this section, Call Hold refers to the unique Call Hold feature of Brekeke PB

Call Hold using REFER requests (Section 9.1

9.5.1. Canceling Call Transfer 1 – Canc

♦ User A executes the cancel Call Transfer command 

♦ User C hangs up call with User A 

 

situation with Figure 6, 9, and 10), the call will be put back to the hold stat

(Figure 17) 

 

 

 

 

 

 

 

 

A

B

C

Talking

A

B

C
A

B

C
Figure 15 Figure 16 Figure 17

Call Hold

Talking

Call Hold

A

B

C

Talking

A

B

C
A

B

C
Figure 15 Figure 16 Figure 17

Call Hold

Talking

Call Hold

 

9.5 . Canceling Call Transfer 2 – Cancel T.2 ransfer While Ringing th

There are two ways to cancel Call Transfer when session is ringing for the 

♦ User A exe

blocking, etc.) 
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A

B

C
A

B

C
Figure 18 Figure 19 Figure 20

A

B

C

Talking Call Hold

Ringing

A

B

C
A

B

C
Figure 18 Figure 19 Figure 20

A

B

C

Talking Call Hold

Ringing

 
 

9.6. Cautions for Call Transfer 
.6.1. Extending Call Transfer 

th regular settings, user C cannot initiate a Call Transfer with the call 

 or B need to first 

 If you need to transfer the call to the 4th party, you need to write settings in the Dial Plan of the 

 

9

In the state of Figure 21 wi

transferred to him/her. For User C to transfer the transferred call, either user A

hang up, then user C can transfer call to user D.  

 

bundled SIP server to redirect the call from User A to C to Brekeke PBX. 
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B

Figure 21 Figure 22

C
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10. Auto Attendant 
The Auto Attendant is a feature that interactively traffics calls without the intervention of a human 

operator. 

ransfer to Auto Attendant 

tended Transfer) to the Auto Attendant (Figure 23), Auto Attendant 

4). Refer to section 9.6.1 “Extending Call Transfer”. 

s initiated from 

the first Call Transfer 

is done instantly, 2  Auto Attendant can transfer the call to the User D. (Figures 25 and 26)  

 

dant to the Non-Brekeke PBX User 

Even when [Transfer to unregistered users] is disabled under [Auto Attendant Settings], 

Call Transfers from Auto Attendant can be made if the non-Brekeke PBX User’s number is set at 

[Default operator] field or [Speed dial] field.  

 

 

10.1. Cautions for Auto Attendant 
10.1.1. Call T

When a call is transferred (At

cannot transfer the call (Figure 2

 

 

 

 

 

 

 

 

 

A

B

Figure 23 Figure 24

Auto Attendant

Call Hold

A

B

Talking

Call Hold

Talking

D
Cannot call the 4th party

Auto Attendant

A

B

Figure 23 Figure 24

Auto Attendant

Call Hold

A

B

Talking

Call Hold

Talking

D
Cannot call the 4th party

Auto Attendant

However, Call Transfer to the 4th party is possible when the Call Transfer i

another Auto Attendant. Since Auto Attendant operates automatically and 
nd
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10.1.2. Call Transfer from Auto Atten

Figure 25 Figure 26
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10.2. Speed Dial Setting Example for Auto Attendant 
10.2.1. Simple Speed Dial settings 

Extension: 001 

Auto Attendant Settings 

Default operator 100 

Speed dial* 
6=200 

7=201 

 

Ring group extension: 200 

Group Extensions* 100, 101 

 

It is handy to set up [Speed dial] ng the Auto Attendant feature.  

r party’s extension, please enter it now. 

If 6 or 7 are pressed, the call will be immediately transferred to the appropriate destinations. 

xtensions*] setting. 

tion that is set in the 

ator].  

 

 With this setting, you will not be able to use the numbers that start with 6 or 7 for extension numbers.  

d Dial settings using Regular Expressions 

nt Settings 

for usi

Your Auto Attendant guidance might say: “If you know you

For sales, press 6. For support, press 7.”  

 

Ring group extension 200 has defined multiple destinations for its [Group E

If there is no entry from the caller, the call will be transferred to the destina

[Default oper

 

10.2.2. Spee

Extension: 001 

Auto Attenda

Max input digits 20 

Speed dial* 6636(.+)=$1 

Transfer to unregistered users disable 

 

Only when the dialed number is 6636 + <number>, the call will be transferred to <number>. 

Other external numbers are not allowed. Because [Transfer to unregistered users] is set to 

disable, it is possible to transfer the call to an external user (such as PSTN number) but the 

caller need to know the first 4 digits (6636).  
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11. Voicemail 
Only Brekeke PBX User extensions have voicemail feature.The Brekeke PBX system treats a 

voicemail inbox number the same as a User ID or extension number.  

g the voicemail prefix number plus their 

details, refer to Section “Prefixes”. 

s voicemail inbox: 

♦ Dialing 07*001 accesses the user 001’s voicemail inbox directly to leave messages  

s for voicemail inbox 

as dialing 08*001 

Each user’s voicemail inbox is the default destination of [Call forward (No answer)] and [Call 

r/Busy)], refer to the 

rding”.  

 

 the caller. You can 

e default greeting.  

rough [Review / Option] (Refer to 

p”) or upload them through Brekeke PBX Admintool.  

alized greeting messages, “Personal Greeting” and “Alternative 

Greeting.” Common use of the “Alternative Greeting” is for special occasions such as long 

ps.  

 

You can also select a greeting message by calling the voicemail inbox and accessing [Review / 

Option], or through the Brekeke PBX Admintool. 

 

 

11.1. Accessing Voicemail 
Users can access their voicemail inbox by pressin

extension number. For 

 

Examples of accessing user extension 001’

♦ Dialing 08*001 retrieves the user 001’s messages, change setting

♦ Pressing “*” (Star) while listening to the voicemail guidance same 

 

forward (Busy)]. For details about [Forwarding destination (No answe

section “Call Forwa

When a voicemail inbox receives a call, specified guidance is given to

choose voicemail guidance from two personalized greetings and th

 

11.2. Greeting Messages 
11.2.1. Recording / Uploading Greeting Messages 

Users can record their personalized greeting messages th

“Voicemail Navigation Ma

 

11.2.2. Selecting a Greeting Message 

Users can have two person

holidays, sick days, and business tri
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11.3. Managing Messages 
The maximum length of the voicemail message that callers can leave is set in the 

Administrator's [Options] menu. The maximum number of voicemail messages that users can 

is also set in the [Options] menu. Users can also set to forward the 

please refer to the 

Retrieving voicemail can be done in several ways.  

d file (WAV file) from the [Voice Mail] menu in Brekeke PBX 

e file, you can listen to the file. 

 

AV file) attached to the email 

1.5. Voicemail Message Status 
ible states, New message or Saved message.  

ing newly arrived    

sages 

ve on the system 

 

rded messages from 

 in the inbox up to the number of days set in the [Days to 

keep unsaved messages] in the [Options] menu. 

Users can save voicemail messages when they are in message review. Saved messages will 

 after the days set in the [Days to keep unsaved messages]. 

1.6. Email Notification 
e arrives at your voicemail inbox, an email notification can be sent to a 

 

11.6.1. Set Up Email Notification 

Detailed settings of Email Notification, such as email address to receive the notification or 

save in their inboxes 

voicemail messages to specific extensions or destinations. For details, 

section “Voicemail Messages: Forwarding and Email Notification.” 

 

11.4. Retrieving Voicemail Messages 

♦ You can download the soun

Admintool. Once you download th

♦ By calling your voicemail inbox and accessing [Review / Option] menu 

♦ By using Email notification setting, and opening sound file (W

 

1
Your voicemail has two poss

♦ New message: a message that you have not saved or erased includ

mes

♦ Saved message: a message that you have chosen to sa

11.5.1. New Message Status 

This status is for the newly arrived voicemail messages, including forwa

other users. This message will remain

 

11.5.2. Saved Message Status 

not be deleted even

 

1
When a new messag

specified email address. 
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message file can only be set at the Brekeke PBX Admintool. Activation and deactivation of the 

email notification features can be changed by calling your voicemail access number without 

accessing Brekeke PBX Admintool. In the Brekeke PBX Admintool, you can set up your email 

mail messages as an 

oicemail Messages: 

of the Messages from Call Recording 

Recorded messages are stored in the same location as voicemail messages. Normally, email 

o send email notification for the recorded 

arting 

Variable for setting call recording email notification: 

RDING_EMAIL_NOTIFICATION=true 

il Notification 
Message 

ers] > [Settings] > 

 will be forwarded to 

ceive the voicemail 

ell as forwarding to 

e field as well. You can 

also forward voicemail messages to a group of destinations by using the forwarding settings. 

 may choose to receive email notifications when new voicemail messages arrive in your 

inbox. You can receive email notifications for messages that have been forwarded to other users 

 

ly User 002 will receive voicemail 

message that came in to User 001 

♦ User 001 enters both email addresses of User 001 and 002. Both User 001 and 002 will 

receive email notifications when User 001 receives a voicemail message 

address to receive notifications and choose whether or not to receive voice

attachment with the notification. For details, please refer to the section “V

Forwarding and Email notification”. 

 

11.6.2. Send Email Notification 

notification will not be sent for recorded messages. T

messages, additional variable is needed to set at [Options] > [Advanced]. Note that rest

Brekeke PBX is necessary to make this change to take effect. 

 

com.brekeke.pbx.Setting.CALL_RECO

 

11.7. Voicemail Messages: Forwarding and Ema
11.7.1. Forwarding Voicemail 

If the extension user has set up voicemail message forwarding at [Us

[Voicemail settings] > [Message forwarding*], all voicemail messages

the specified destinations. You can assign multiple destinations to re

messages. If you want to leave a copy of voicemail message as w

destinations, you will need to specify your voicemail inbox number in th

 

11.7.2. Email Notifications 

You

as well. 

 

Example:  

♦ User 001 sets messages to forward to User 002. On
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11.7.3. Max Messages 

Brekeke PBX System Administrators can set the limit of the number of messages that users can 

have in their voicemail inboxes. [Options] > [Media Server system setting] > [Max stored 

When the number of voicemail messages in the inbox reaches the maximum 

will hear the system 

ho has reached the maximum number of messages in their 

inbox will not be accepted. If you are forwarding your voicemail messages to multiple 

ached the maximum 

1.8. Voicemail Inbox Access Limitation 
 a single user access at a time. When you are accessing 

e Brekeke PBX 

ll be locked to other 

sses. 

 

 

messages]. 

number, callers cannot leave messages in your voicemail inbox. Callers 

default message, “The message inbox is full.” 

 

A message forwarded to a user w

destinations, the message will also be forwarded to inboxes that have not re

number of messages. 

 

1
Each voicemail inbox will only allow

voicemail inboxes using a phone, you cannot modify your settings through th

Admintool. When other is using your voicemail inbox, your voicemail wi

acce
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12. Automatic Route Selection (ARS) 
Most of the call management rules for outgoing and incoming calls through outside lines are set 

at Automatic Route Selection.  

vers 

software which is not the bundled SIP server that comes 

X. Common third party SIP servers are those that are located at VoIP 

e are SIP PSTN Gateways that connect digital and analog 

cols. 

g rules enables ARS to make optimal use of outside lines, and your gateways. In the 

calls, and which lines 

g calls. 

 

ling options 

ic call long distance 

branch office located in Taipei. With ARS feature, the least 

 be utilized.  

s may be used 

others. The ARS feature can be used to select the most effective 

subscribe to multiple VoIP service providers, some 

ature can be used to 

ork Traffic Management and Load Balancing 

When many sessions are in progress and server load is too high or network bandwidth is 

insufficient, The ARS feature can be used to direct some calls through PSTN Gateways for 

example.  

 

Common outside lines that the PBX connects to: 

♦ Third Party SIP Ser

Third Party SIP Server is server 

with Brekeke PB

service providers, or other office locations. 

♦ Gateways 

 gateways referred to herThe

PSTN lines or software gateways that convert between different proto

 

Definin

[ARS] menu, you can define extension numbers that will receive incoming 

to use for outgoin

Here are some examples of uses for ARS feature: 

♦ Select the least expensive cal

For example, you can send all international calls through a specif

carrier, or to connect to the 

expensive calling option can

♦ Effective port use of PSTN Gateways 

When there are multiple PSTN Gateways installed in the office, some port

more frequently than 

PSTN Gateway port automatically. 

♦ Effective Use of Outside Lines 

Similar to the above example, when you 

phone numbers may be used more frequently than others. The ARS fe

select the most effective service provider automatically. 

♦ Netw
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♦ Failover 

With ARS failover, Brekeke PBX searches for an alternate route if the specified route is 

unavailable or has failed, and makes outgoing calls via the alternative route. For example, 

ou have multiple ITSPs (Internet Telephony Service Providers) or/and PSTN (Public 

up connections if the 

is situation, Brekeke 

 gateway. The route 

 

12. te Search Process 
or one call in Brekeke PBX. Please refer to the section 5 “Call Process 

When A calls B, the SIP session which is initiated by A will be answered by Brekeke PBX. 

es 

e outgoing session. 

 

ll. The Route Search 

s. If multiple patterns 

pattern is found, the 

attern has sessions 

pattern and convert the From and To header fields 

according to the settings defined in [Deploy Patterns]. 

 and the session will 

mber. You also need to take care to ensure that calls 

between extension users do not match ARS rules, because those calls need not be routed 

 

For outgoing calls, it is necessary to set priorities for effective routing depending on the usage of 

lines. 

 

 

if y

Switched Telephone Network) gateways, Brekeke PBX allows for back

VoIP (Voice over Internet Protocol) or internet connection is lost. In th

PBX would automatically switch to an analog route through the PSTN

can be re-activated manually from the Brekeke PBX Admintool or automatically by preset

settings.  

 

1. Rou
Two sessions are used f

Flow” for the details of session processing during calls.  

 

Brekeke PBX will process ARS Pattern-IN for the incoming session. Also Brekeke PBX initiat

a session with B. Brekeke PBX will process ARS Pattern-OUT for th

Route search is done by searching for Matching Patterns that apply to a ca

starts from the highest priority (lowest number) as defined by the ARS rule

share a priority level, a pattern is selected randomly. When a matching 

process will check if the [Max Sessions] value has been reached. If the p

available, the process will select the 

 

For incoming sessions, Brekeke PBX will check if any ARS route matches

be routed to an appropriate dial-in nu

through your gateway and third party SIP provider.  
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12.2. Matching Patterns 
Using regular expressions enter conditions for To or From headers, etc. for the matching 

process. If the fields are left blank, all calls will be considered to match the condition. The fields 

me way as [Matching Patterns] fields in the Dial Plan. If the fields are left 

rs for using the ARS 

pattern. “User” of the call for the ARS rule will be determined as follows: 

ber is considered as 

 Brekeke PBX user’s 

 

s “User” of the call. 

ller will be considered 

pplicable, no user will considered as the “User” of the call. 

 

 matching conditions 

eloper’s Guide”. 

 

 similar to [Deploy Patterns] fields in Dial Plan; however, there are several important 

” in Dial Plan) 

e as described in 

s defined in [Deploy 

s] for To header, DTMF and Target field (In Dial Plan rules, multiple lines can be 

d it is process at the 

ble to use a value in 

o, and User. 

parenthesis in [Matching Patterns]>[From] 

♦ If From or To field is blank, no conversion will be performed. If DTMF field is blank, no 

DTMF will be sent. If Target field is blank, no target IP address will be specified (The call 

will be routed to the domain specified in To field in most cases). 

can be set in the sa

blank, any call will match the rule. 

 

Using [User] field of ARS Pattern-OUT setting, it is possible to restrict use

1) If the destination number is Brekeke PBX user, the destination num

“User” of the call. 

2) If 1 is not applicable and also if the calls is forwarded through some

[Other Forwarding destinations], [Forwarding destination (No answer)] or [Forwarding

destination (Busy)] setting, the Brekeke PBX user will be considered a

3) If 2 is not applicable and also if the caller is Brekeke PBX user, the ca

as “User” of the call. 

4) If none of the above is a

[Plugin], [Param], [Return] fields are used only when you want to extend the

using a JAVA plug-in. Please refer to “ARS Plug-in Dev

12.3. Deploy Patterns 
This is

differences: 

♦ Numbers follow the “$” sign in [Deploy Patterns] in ARS rules. ( Use “%

♦ Conversion of From header that matches in [Matching Patterns] is don

[Deploy Patterns] for From header. Conversion of To header is done a

Pattern

defined in [Matching Patterns] fields and [Deploy Patterns] fields an

same time).  

♦ By using &f<n>, &t<n>, &u<n> in [Deploy Patterns] fields, it is possi

parenthesis of some [Matching Patterns] field . &f, &t, &u correspond to From, T

For example: &f1 refers to the value in the first 
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12.4. ARS Templates and Editing Variables 
It is possible to create a template in ARS Settings for multiple ARS rules that have same 

configuration patterns. In [Running Status], real rules (not template) will be displayed. In the 

 name], [Descriptions], and [Parameters]), you can use 

s].  

ct multiple SIP UAs through an external interface. With this, 

-to-Call” and “Autodialer”.  

terface, you can access Brekeke PBX 

1) Set the allowed IP patterns at Brekeke PBX Admintool > [Options] > [PBX system settings] 

ith the IP addresses 

 

 

rmat 

>:<server-port>/pbx/3pcc?to=<callee-number>&from=<caller-number>

&user=<caller-user>&type=<type> 

ip-add talled on 

>  Admintool 

mbe r its SIP URI. You can specify multiple numbers by 

<caller-number its SIP URI. 

ou can omit this if 

this is same with “caller-number”. 

ions simultaneously. 

ecify “2” when you want to connect Caller before connecting Callee.  

Response 

Brekeke PBX will return the response: “succeeded: ID number”. This ID will be the ID used at 

[Call Status] screen for the session.  

template fields (excluding fields: [Route

the variables &v1, &v2,…., $v9. You can specify real values in [Edit variable

 

13. Third Party Call Control 
Using this feature, you can conne

you can create systems like “Click

 

Using HTTP-GET (or POST) and Web Service in

externally. Here we will explain the method using HTTP-GET.  

 

> [Valid client IP Pattern] using Regular Expressions.  

2) Access the URL (format as below) using HTTP protocol from the PC w

set at [Valid client IP Pattern]. 

URL fo

http://<server-ip-address

 

<server- ress> IP address of server where Brekeke PBX is ins

<server-port The same port number you use accessing Brekeke PBX 

<callee-nu r> Callee’s number, o

dividing number using comma. 

> Caller’s number or 

<caller-user> Brekeke PBX User which is used to call out (caller). Y

<type> Specify “1” when you would like to call destinat

Sp
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